The essentials of imaging
Table of Contents

Customizing MyTab ................................................................. 3
Placing a Watermark on a Print Job ........................................ 6
Image Overlay ........................................................................ 7
Front & Rear Covers with an Insertion Sheet ......................... 9
Booklet Creation—Booklet Legal ........................................... 11
Tri-fold Creation ................................................................. 12
Secure Print ......................................................................... 13
Print from USB .................................................................... 15
Banner Printing ................................................................. 16
Customizing MyTab

PRE-REQUISITES:
The MyTab feature is inherent in the Emperon® PCL and PS Drivers. All that is required of the end user is to install the print drivers following the normal installation procedure. There are no additional steps necessary. When the end user clicks on the Properties menu of the PCL or PS Driver, they will immediately have access to MyTab.

APPLICATIONS:
The beauty of MyTab is that it can meet all types of applications. The purpose of this tab is to enable end users to "customize" the driver based upon their printing needs. Therefore, the customer that produces a lot of booklets would set up the "Booklet" and "Center Fold and Staple" Settings on MyTab in the section (left side, right side) that is most convenient for them. A user that does a lot of 11” x 17” duplexing may set up the "Output Size" and "Duplex" on MyTab. Yet another user may require Watermarks on their print jobs and want the Watermark feature on MyTab. Since many settings can be set on MyTab, it is possible for all the aforementioned settings to appear on MyTab and they can be arranged in the order desired by the end user.

With MyTab, end users have the most frequently used settings virtually at their fingertips and they are able to change the layout of MyTab as often as they like. There are no restrictions to the number of times they can change it or the order that they list the functions. Best of all, it’s quick and easy to customize.

Steps/Keystrokes:
1. Open a document and select File.
2. Select Print.
3. Select MFD.
4. Click on Properties.
5. Click on MyTab — First time you bring up the driver.
6. Click on More Details.
7. Click on “X” in the right hand corner to close the screen when you have completed reviewing the information.
Let’s take a look at how you would **Edit** “MyTab” to meet your needs –

1. Click on **Edit MyTab** found in the lower half of the print driver.

The following **Setting Item List** within the **Edit MyTab** menu will appear. This is where you will designate what settings you want to appear on MyTab.

Let’s move **Output Method** to the right hand side of the driver and **Copies** to the left hand side of the driver.

Click on **Output Method**.

Click on **↔ Left/Right** to move **Output Method** to the right side of the **Print Driver**.

Please note that you can move settings between the left and right sides of the printer driver screen and you can move the order of the settings up and down on the printer drivers screen.

Note: If you wish to move the order of the selections available, click on the desired selection and click **↑ Up** or **↓ Down** until the selection is in the desired position.
Now, we’ll move on to the **Stamp/Composition** tab to place the **Watermark** menu on the right side of **MyTab**.

1. Click on **Edit MyTab**.
2. Click on the **Stamp/Composition** tab.
3. Click on **Watermark**.
4. Click on **to the RIGHT**.

Watermark moves down to the **RIGHT** side of the **MyTab Edit** screen.

Click **OK** to view the **Watermark** selection on **MyTab**.

**BENEFITS**

- User is able to customize the print driver based on their needs.
- User is able to customize the print driver based on the “look and feel” they find the easiest to use.
- Increased productivity due to the ability to select most commonly used functions from **ONE** tab.
- **MyTab** can be repeatedly changed and updated as needs changes.
Placing a Watermark on a Print Job

PRE-REQUISITES:
You will need a Word document or any document ready to print from your PC.

APPLICATION:
You want the ability to place watermarks such as Confidential, Do Not Copy, Draft and Proof, etc. on certain printed documents. What keystrokes are necessary to watermark printed documents?

Steps/Keystrokes:
1. From the document select **File**.
2. Select **Print**.
3. Select the **MFD**
4. Click on **Properties**.
5. Select the **Stamp/Composition tab**.
6. Check **Watermark**
7. Select **TOP SECRET** from the dropdown menu.
8. Select **Edit** under Watermark to adjust the image as desired.
**Image Overlay**

**PRE-REQUISITES:**
You will need an 8.5” x 11” Word document with a logo or create text in a document to serve as your overlay image.

**APPLICATION:**
You have to print an 8.5” x 11” document with the company logo.

**Steps/Keystrokes:**
An overlay must first be created.

1. Open a document with a logo or simply type something in the blank Word document that will serve as your overlay.
2. Select File.
3. Select Print.
4. Select the MFD.
5. Click on Properties.
6. Select the Stamp/Composition tab.
7. Click Default to restore default settings.
8. Select Create Host Image from the Overlay dropdown menu.
9. Click OK.
10. Click OK.

You can now select where to save the overlay locally on your PCs hard drive.

File name: Name the file, ‘KM Logo Overlay’ for example.

Save as type: This will be a .KFO file.

Overlay Name: Optionally, you can give the overlay a different name.

Click Save.

You have now saved the overlay to be used for future documents.
USING THE IMAGE OVERLAY FROM THE PCL PRINT DRIVER

1. Open a document or create one.
2. Select File.
3. Select Print.
4. Select the MFD.
5. Click on Properties.
6. Select the Stamp/Composition tab.
7. Click Default.
8. Select Print Host Image from the Overlay dropdown menu.

NOTE: You may be required to deselect Create Overlay File in order to select Print in Overlay.

9. Select the overlay file you created earlier.
10. Click OK.
11. Click OK.

Your document will print with the image overlay you selected.
Front & Rear Covers with an Insertion Sheet

PRE-REQUISITES:
You will need an eight page Word document, “letter size” (8.5” x 11”) containing text. Load 8.5” x 11” color paper in Tray 1. Load white paper in Tray 2.

APPLICATION:
You need to print colored front & rear covers for your documents and also insert a blank sheet within the finished set.

Steps/Keystrokes:
1. From the document select File.
2. Select Print.
3. Select the MFD.
4. Click on Properties.
5. Under the Basic Tab change the Paper Tray from Auto to Tray 2 (This specifies Tray 2 as the paper to be used for the document file).
6. Under the Finish Tab Select Staple.
7. From the pull down menu select 2 Position (Left).
8. Select the Cover Mode tab.
9. Select Front Cover and then Blank from the pull down menu.
10. Under the Front Cover Tray, select Tray1 from the pull down menu.
11. Select Back Cover and then Blank from the pull down menu.
12. Under the Back Cover Tray, select Tray1 from the pull down menu.
13. Select Per Page Setting.
14. Click on Edit List.
15. Click the Add tab.
16. At Change Settings select the dropdown menu and designate Insert Blank Sheet.
17. Under Page Number, type the number 1 (this indicates the blank sheet will be inserted after page
one of the original file).

18. Highlight “Paper Tray” within the “Add/Edit” field.

19. Under Change Settings, select Same as Body from the pull down menu.

20. Click OK.

21. Click OK.

22. Click OK.
Booklet Creation — Booklet Legal

The Booklet function is available only when the optional finisher FS-526 is installed.

PRE-REQUISITES:
You will need an eight page, 8.5" x 11" Word document with text. In addition, you must load legal size 8.5" x 14" paper in one of the cassettes.

APPLICATION:
You need to create an 8.5" x 14" stapled and folded booklet from a word document that is 8.5" x 11".

Steps/Keystrokes:
1. From your Word document select File.
2. Select Print.
3. Select the MFD.
4. Click on Properties.
5. Under the Basic Tab the original Size should be set to 8.5" x 11" and the Paper Size should be set to 8.5" x 14".

Notice the view of your selection in the upper left corner of the print driver. This confirms your selection of an 8.5" x 11" original to an 8.5" x 14" output.

6. Click on the Layout Tab
7. Go to Print Type dropdown menu and select Booklet.

Notice the view of your selections in the upper left corner of the print driver. It now shows the original size, the output size, and the booklet selection.

8. Click on the Finish Tab.
9. Select Center Staple and Fold.

Notice the view of your selections in the upper left corner of the print driver.

10. Click OK.
11. Click OK again and your booklet will be in booklet output tray.
Tri-fold Creation

The Tri-fold function is available only when the optional finisher FS-526 is installed.

PRE-REQUISITES:
You will need a 1-page original document (8.5" x 11" in size).

APPLICATION:
You have a document prepared for folding such as an advertising flyer or a rebate special, etc. You may want to print this document either single sided or duplexed and apply a tri-fold to finish the document. You want to place the image(s) of their digital file on Letter Size Paper (8.5" x 11").

Steps/Keystrokes:
1. From your document select File.
2. Select Print.
3. Select the MFD.
4. Click on Properties.
5. From the Basic tab, you will create your finishing and output choices.
6. Click on Original Orientation.
7. Click on the Radio dial so it indicates Portrait.
8. Click on Original Size dropdown menu to indicate 8.5" x 11".
9. Leave Paper Size on Same as Original Size.
10. Leave Paper Tray on Auto.
11. In the upper right side of the print properties; leave output method on Print.
12. Click on the Layout tab.
13. Click on the Finishing tab.
14. Click on Fold.
15. From the Fold dropdown menu, click on Tri-fold.
16. Leave Paper Arrangement Field at it’s default Prioritize Arranging Papers.
17. Click OK.
18. Click OK.
Secure Print

SECURE PRINT
Secure Print allows security to be imposed upon a document to be sent to the bizhub MFD for printing. The document will be “printed” to a secure User Box and cannot be accessed, printed, or even viewed without first entering its authentication data at the MFD.

Secure Print is a very powerful feature as it allows security control of a document “on the fly”. The security data is imposed on the document in the print driver as a one-time function that applies only to that specific printing of that specific document at that specific time. No prior programming is required to use Secure Print.

APPLICATION:
You have a document prepared and you want to print the document to the bizhub MFD, however you do not plan on retrieving the document until later in the day. You also want to have the document safeguarded from any other people in their organization being able to see it.

Steps/Keystrokes:
1. From your document select File.
2. Select Print.
3. Select the MFD.
4. Click on Properties.
5. On the Basic tab, use the Output Method pull down menu to select Secure Print.
6. Select User Settings
7. Enter an ID that is 1 to 16 characters long (in this case, enter Secure)
8. Enter a password that is 1 to 8 characters long (in this case, enter x)
9. Click OK
10. Click OK
11. Click OK
RETRIEVING A SECURE PRINT AT THE BIZHUB MFP

Note: Secured documents are automatically deleted as soon as they are printed, or after a set length of time after they are registered. The default setting of this time is specified as 1 day, and the duration can be changed by an Administrator with the device password.

1. Press the User Box key in this systems control panel (Below the Touch Screen Panel).
2. Select System User Box.
3. Select Secure Print User Box (it will highlight in Green).
4. Touch Use/File.
5. Touch OK
7. Touch OK.
8. Type in the password for the ‘Secure Print Document’ – (in this case, x), touch OK.

9. Select the document by touching th Icon and touch Print.
10. Touch Start or press the Start key in the control panel (To cancel printing the job, touch Cancel).
Print from USB

PRE-REQUISITES:
You will need a USB device that contains your originals with text or graphics.

APPLICATION:
You will be traveling to your client’s office for a meeting where you know there is an MFD. You do not want to carry the print-outs with you. Once you have stored your files in your USB device you can print – all you need to do is just to plug in your USB.

PRECAUTIONS:
• You can not edit the files already in the USB device.
• You can not move files from the USB device to the User Box.
• You can not print preview the files in the USB device.
• Double-sided printing, punching, and stapling of JPEG and XPS format files is not possible.
• If double-sided printing is selected for PDF and TIFF format files, then these will be printed as left bound.
• If two or more sets of double-sided printing with stapling, or punching are selected, then the binding direction can be specified in the settings to specify the staple and punch location.
• A maximum of 255 files of a format that can be printed can be displayed within the folder in the specified file path. If there are 256 or more files within a single folder, then display of the file list screen display may become slower.

Steps/Keystrokes:
1. Plug the USB device to the MFD. The USB port is located at the upper right side of the MFD towards the front.
2. A screen comes up on the MFD that tells you an external memory is connected.
3. Press OK
4. Press User Box hard key on the control panel.
5. Touch System User Box.
6. Touch External Memory at the right bottom corner of the screen.
7. Touch Use File
8. Files on your USB will appear on the MFD’s screen. Touch the desired folder (or file).
9. Touch open (if you select a folder)
10. Select desired original file.
11. Touch Print
12. The Print Settings screen comes up. If necessary, specify any other print settings by touching the Finishing tab or Paper tab.
13. Press Start
Banner Printing

The Banner Printing function is not available when the optional finisher FS-526 is installed.

*Note that Banner Printing can only be done on Thick 1 paper. The printer driver will automatically choose this setting.*

**PRE-REQUISITES:**

You will need one banner size original with text or graphics in digital format and banner size paper to feed into the bypass.

**Steps/Keystrokes:**

**AT THE MFP**

1. Touch the **Utility/Counter** hard key on the control panel.
2. Touch **Banner Printing**.
3. Touch **ALLOW**.
4. The following message will be displayed on the MFP’s touch screen:

   “**Touch EXIT to quit banner printing**”.

5. Place banner paper in the bypass of the MFP (be careful to adjust the paper guides precisely to the correct setting).

**AT THE PC**

1. Go to **START**.
2. Select **Settings**.
3. Select **Printers & Faxes**.
4. Choose the **MFD**.
5. Right click then choose **Properties**.
6. Select **Printing Preferences**.
7. On the **Printing Preferences** screen go to **Original Size** tab.
8. Choose **Custom Size** from the drop down menu.
9. The **Custom Setting** screen comes up. Enter the Banner dimensions: For example, Width 11.69 Length 47.24
10. Press **OK**.
11. The **Confirm Setting Changes** screen comes up.
12. Press **YES**.

13. Press **APPLY**.

14. Press **OK**.

15. Open your banner original.

16. Select **Print**.

17. Select the MFD.

18. Click on **Properties**.

Note that the proper size of the banner paper is not displayed at this time.

19. Click **Original Size**.

20. Scroll down to **Custom Size**.

21. Click **Custom Size** – a dialogue box will open.

22. Enter the Width and Length of the banner paper

   For example, Width 11.69 Length 47.24

23. Click **OK**.

24. If a dialogue box (message error) appears click **YES**.

25. The Setup tab of the PS print driver will appear and display the message, "In the bypass tray, place paper with the print side down."

26. Click **OK**.

Note that the size of the banner is now properly displayed in the Preview window.
27. Click **OK**.

28. The MFP screen will now display the message, "Receiving print job." Then the message, "Please wait" will be displayed.